Guidance for the Production of Source Documents for Transcription into Accessible Formats

Guidance from UKAAF

UK Association for Accessible Formats (UKAAF)
Because format quality matters
Why format quality matters

"When organisations send me information in formats that I can read myself it allows me to be independent, feel informed and appreciated - just like every other customer."
End-user

"Producing consistently high quality accessible formats helps us to maintain our reputation, to gain new customers and to retain existing ones."
Transcription agency

"We are committed to ensuring that our customers with print disabilities receive the same information, of the same quality, as everyone else."
Service provider
Who is this guidance for?

This guidance from the UK Association for Accessible Formats (UKAAF) is primarily aimed at schools and academic institutions, awarding bodies, designers and transcribers. It will be particularly useful for any organisation producing an assessment in PDF format to ensure they are made accessible for candidates with print impairments. This document is guidance, for experienced desktop publishers: it is not a detailed training manual. Please refer to the Further Resources section for sources of training materials.

Disclaimer

This guidance may include references to external websites, services or products for which UKAAF accepts no responsibility. This information is given without any representation or endorsement of those websites, services or products.
# Contents

- Why format quality matters ................................................................. 3
- Who is this guidance for? .................................................................. 4
- Disclaimer ......................................................................................... 4
- Contents .......................................................................................... 5
- 1 Acknowledgements ......................................................................... 7
- 2 Introduction .................................................................................... 7
  - 2.2 Benefits of good practice ............................................................. 8
- 3 Document content - organisation ................................................... 12
  - 3.1.1 Tables of Contents .................................................................. 14
- 4 Summary .......................................................................................... 29
- 5 References ....................................................................................... 29
- 6 Appendices - general Notes .............................................................. 30
- 7 Appendix 1 Using styles and templates ........................................... 30
- 8 Appendix 2 Creating & customising a Table of Contents .............. 35
- 9 Appendix 3 Paragraph, line, page, section and column breaks .... 36
- 10 Appendix 4 Editing headers and footers ........................................ 38
- 11 Appendix 5 A small selection of useful shortcut keys ............... 39
  - 11.1 Useful shortcut keys in Windows .............................................. 39
    - 11.1.1 Opening and closing programs ......................................... 40
    - 11.1.2 Moving around in Windows .............................................. 40
    - 11.1.3 Working with menus in Windows programs .................. 40
    - 11.1.4 Cut, copy and paste in Windows ................................. 41
  - 11.2 Useful shortcut keys in Word .................................................... 41
    - 11.2.1 Opening and closing documents ..................................... 41
    - 11.2.2 Moving around in Word .................................................. 42
    - 11.2.3 Working with menus in Word ........................................... 42
    - 11.2.4 Cut, copy and paste in Word ........................................... 42
    - 11.2.5 More shortcuts in Word ................................................... 43
- 12 Appendix 6 Creating and modifying shortcut keys .................... 43
- 13 Appendix 7 Typing in foreign languages ...................................... 47
- 14 Appendix 8 Adding Alt text to a graphic image ......................... 50
1 Acknowledgements

Four documents (listed in the References section) have been drawn upon for this guidance, along with the author’s own knowledge and sources such as software online Help facilities. The four main documents concentrate on either the creation of source documents for transcription, or the creation of accessible electronic documents, or a mixture of these, because the requirements overlap a great deal.

There is general agreement between the referenced sources about most of the principles of good practice described here, although there are some differences in detailed interpretation, such as the desirable number of heading levels in the organisation of a document. The overriding requirement is that the person creating source documents for transcription should be aware of the requirements, skills and context of the users of their transcriptions.

2 Introduction

2.1 Overview

The main aim of this guidance document is to describe good practice, including some technical detail, in the preparation of electronic documents (word processor files) that are to be used as the ‘source’ documents for transcription into one or more alternative formats. The most common alternative formats are modified print, braille, audio (mp3, DAISY etc) or electronic documents that are accessible to screen magnification and screen reader software. Ideally a single source document that is prepared appropriately can be used as the basis for versions in a variety of alternative accessible formats. The elements of good practice described here can help to make the process of transcription quicker and more accurate than it would otherwise be.
This document does not stand in isolation, but exists alongside other guidance documents from UKAAF, in particular (at the time of writing) the Minimum Standards documents MS01-4, Guidance documents G002-19 and documents related to braille production. There is necessarily some overlap of information between these documents. This one focuses on good practice in the organisation of the source document content, in terms of sections and section headings for example, and gives some tips on how to implement that good practice by the use of templates, styles and other less well-known features of word processors. In some instances the other Minimum Standards and Guidance documents give greater detail than this document about the requirements of particular accessible formats.

2.2 Benefits of good practice

The main technical guidance is given in the Principles section below and in the Appendices, but it might help if the benefits of following this guidance are explained briefly.

It is more or less self-evident that good organisation of a document, in terms of sections and sub-sections, headings and sub-headings, numbering where appropriate, and the use of facilities such as bulleted lists, will all contribute to make the document as accessible as possible to a variety of users. The editor of the source document may not have freedom to change these aspects, especially if it must reflect a published original as faithfully as possible, but they will be able to choose how to implement them using a range of facilities within their editing software. An appropriate choice will allow an almost instantaneous accurate transcription into any of several alternative formats.

The simplest illustration of this is perhaps the transcription of a source document into modified print. (This most commonly takes the form of large print, although colours, spacing and other features can also improve the accessibility of a document.) If a
template containing styles is used in the source document, as recommended below, the content can be imported with a few keystrokes into a different template, based on a different set of font sizes, colours etc. It then only remains to check layout details such as pagination and graphic image locations; the content is likely to need little further proof-reading.

Similarly, with a little care braille transcription software is usually capable of turning a template of print styles into a corresponding set of appropriate braille styles. Some other features, such as the correct use of mathematical symbols in the source document, can also assist the transcription into correct braille.

1.1.1 Styles & templates

The basic ideas behind styles & templates

Any part of the text in a source document can be given a wide variety of appearances by selecting the font, size, weight, colour, spacing and so on by choosing from the ribbon display or menus. A 'style' in this context is a definition of a particular set of such type characteristics. Creating and editing a document is much more efficient and consistent if styles are used for the basic paragraph text, for bulleted or numbered lists, for headings and other types of content. For instance, if Heading Style 2 is used for all main section headings and the user wishes to change these headings retrospectively from 16 point to 18 point, it is only necessary to modify the style definition. All text with that style setting will be changed simultaneously. If the heading style was not used it would be necessary to change all of the section headings individually.

There is a further advantage to using styles in source documents for transcription, namely that it is relatively easy to apply a different set of styles to a document, appropriate to the alternative format version being created, such as modified print or braille. Sets of styles for different purposes can be stored in special documents called 'templates'.
This document is based on a template which includes the following styles:

- **Body Text1**: ordinary paragraph text – Arial 14 point, left-aligned, line spacing = 1.25, blank space before each paragraph = 6 point, blank space after each paragraph = 6 point

- **Title**: main title of the document – Arial 26 point, bold, Kern at 14 point, left indent = −0.2", single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 6 point

- **Subtitle**: secondary title of the document – Arial 22 point, bold, left indent = −0.19", single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 1 point

- **UKAAF heading 1**: main section heading – Arial 18 point, bold, left aligned, single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 6 point

- **UKAAF heading 1 (numbered)**: first level section headings, numbered – Arial 18 point, bold, left aligned, hanging indent = 0.34", single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 6 point

- **UKAAF heading 2 (numbered)**: second level section headings, numbered – Arial 16 point, bold, left aligned, hanging indent = 0.4", multiple line spacing = 1.25, blank space after each paragraph = 5 point

- **UKAAF heading 3 (numbered)**: third level section headings, numbered – Arial 14 point, bold, left aligned, hanging indent = 0.63", multiple line spacing = 1.25, blank space after each paragraph = 4 point

- **Heading 4**: fourth level headings – Arial 14 point, bold, left aligned, hanging indent = 0.79", blank space before each paragraph = 6 point, blank space after each paragraph = 3 point

- ... (and so on)
It can be seen that the relative sizes of print reflect the organisation of the document, encompassing such features as the relative importance of different levels of headings and the main text. This organisational aspect is further reflected if a Table of Contents is created automatically. The styles are used by the software to determine how many levels of headings and sub-headings are included in the Table of Contents and indentation is used to illustrate the hierarchy of heading levels.

**Types of style**

There are four types of style in MS Word: paragraph styles, character styles, list styles and table styles.

- A paragraph style applies to the whole paragraph in which it is applied, regardless of where the cursor is at the time the style is selected. It includes the spacing between paragraphs and the behaviour in relation to adjacent paragraphs, as well as the type characteristics. (It can be helpful to set the Show/Hide feature in Word to Show so that end of paragraph marks are made visible during editing.)

- A character style applies only to selected text within a paragraph, list or table. In effect it overrides the paragraph style, but only for the selected text. (See the Foreign languages section below for an example of the use of a character style in source files for braille.)

- List styles are used to determine the displayed and organisational characteristics of bulleted or numbered lists.

- Table styles are used to set the characteristics for information presented in table form.

It can be seen that the use of styles has many advantages. It should be an essential element in the creation and editing of any source document for transcription into alternative formats.

For further details about using styles and templates see Appendix 1.
3 Document content - organisation

The basic ideas behind styles & templates

Any part of the text in a source document can be given a wide variety of appearances by selecting the font, size, weight, colour, spacing and so on by choosing from the ribbon display or menus. A 'style' in this context is a definition of a particular set of such type characteristics. Creating and editing a document is much more efficient and consistent if styles are used for the basic paragraph text, for bulleted or numbered lists, for headings and other types of content. For instance, if Heading Style 2 is used for all main section headings and the user wishes to change these headings retrospectively from 16 point to 18 point, it is only necessary to modify the style definition. All text with that style setting will be changed simultaneously. If the heading style was not used it would be necessary to change all of the section headings individually.

There is a further advantage to using styles in source documents for transcription, namely that it is relatively easy to apply a different set of styles to a document, appropriate to the alternative format version being created, such as modified print or braille. Sets of styles for different purposes can be stored in special documents called 'templates'.

This document is based on a template which includes the following styles:

- **Body Text1**: ordinary paragraph text – Arial 14 point, left-aligned, line spacing = 1.25, blank space before each paragraph = 6 point, blank space after each paragraph = 6 point
- **Title**: main title of the document – Arial 26 point, bold, Kern at 14 point, left indent = −0.2", single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 6 point
- **Subtitle**: secondary title of the document – Arial 22 point, bold, left indent = −0.19", single line spacing, blank space before
each paragraph = 12 point, blank space after each paragraph = 1 point

- UKAAF heading 1: main section heading – Arial 18 point, bold, left aligned, single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 6 point

- UKAAF heading 1 (numbered): first level section headings, numbered – Arial 18 point, bold, left aligned, hanging indent = 0.34", single line spacing, blank space before each paragraph = 12 point, blank space after each paragraph = 6 point

- UKAAF heading 2 (numbered): second level section headings, numbered – Arial 16 point, bold, left aligned, hanging indent = 0.4", multiple line spacing = 1.25, blank space after each paragraph = 5 point

- UKAAF heading 3 (numbered): third level section headings, numbered – Arial 14 point, bold, left aligned, hanging indent = 0.63", multiple line spacing = 1.25, blank space after each paragraph = 4 point

- Heading 4: fourth level headings – Arial 14 point, bold, left aligned, hanging indent = 0.79", blank space before each paragraph = 6 point, blank space after each paragraph = 3 point

- ... (and so on)

It can be seen that the relative sizes of print reflect the organisation of the document, encompassing such features as the relative importance of different levels of headings and the main text. This organisational aspect is further reflected if a Table of Contents is created automatically. The styles are used by the software to determine how many levels of headings and sub-headings are included in the Table of Contents and indentation is used to illustrate the hierarchy of heading levels.

**Types of style**

There are four types of style in MS Word: paragraph styles, character styles, list styles and table styles.
A paragraph style applies to the whole paragraph in which it is applied, regardless of where the cursor is at the time the style is selected. It includes the spacing between paragraphs and the behaviour in relation to adjacent paragraphs, as well as the type characteristics. (It can be helpful to set the Show/Hide feature in Word to Show so that end of paragraph marks are made visible during editing.)

A character style applies only to selected text within a paragraph, list or table. In effect it overrides the paragraph style, but only for the selected text. (See the Foreign languages section below for an example of the use of a character style in source files for braille.)

List styles are used to determine the displayed and organisational characteristics of bulleted or numbered lists.

Table styles are used to set the characteristics for information presented in table form.

It can be seen that the use of styles has many advantages. It should be an essential element in the creation and editing of any source document for transcription into alternative formats.

For further details about using styles and templates see Appendix 1.

3.1.1. Tables of Contents

The original document on which the source document is based might not be big or complex enough to warrant the inclusion of a Table of Contents. However, it is not uncommon for versions in alternative formats such as modified print and braille to have many more pages than the original. The inclusion of a Table of Contents can improve the accessibility and ease of navigation in the alternative format version.

A Table of Contents can be created quickly and easily in the source document, as long as heading styles have been used throughout. Also it can be updated easily when new material is added or surplus material removed.
There is a variety of opinions regarding the ideal number of levels of headings. If there are too few then the ability to reflect the logical relationship between parts of the document is restricted. If there are too many then it becomes difficult to appreciate the relationship between them by visual characteristics, such as font size. It is worth bearing in mind that it might be helpful to have as many as 4 or 5 heading levels, but that they do not all need to be displayed in the Table of Contents.

For further details about creating and customising a Table of Contents see Appendix 2.

### 3.1.2. Pagination

The appropriate positioning of page breaks can contribute to the accessibility of a document. It is often preferable to start a new page at a new section or paragraph. Items which are naturally grouped together with a logical connection, such as a list, are better kept together on the same page, if possible.

For further details about the correct way to create page breaks see Appendix 3.

### 3.1.3. Page Headers & Footers

Headers and footers contain information that is repeated on every page, i.e. information that is not part of the main flow of the document content, such as page numbers. In a source document for transcription to braille, for example, it is common practice to include a brief title and the braille page number in a header.

Alternatively the header might contain a chapter or section number in the header as a navigational aid in a long document. It might be necessary to include section breaks in the source document to ensure that the change from one chapter or section to the next is reflected at the correct place in the header.

For further details about editing headers and footers see Appendix 4.
3.2. Document content - types of material

3.2.1. Obtaining an electronic version of the text

The starting point for a source document is an electronic copy of the material that is to be transcribed into accessible formats. This might already be available in a format that can be edited, such as a Word document. If it is available in another file format, such as pdf or html it might be possible to import it to Word or to copy and paste it. In these cases it is likely that some aspects of the original are not reproduced exactly in Word and will require attention.

Another way to obtain an electronic copy is to scan the material and to process it in Optical Character Recognition (OCR) software. Again this is unlikely to reproduce all of the original material exactly. In addition there might be scanning errors, such as mistaking a numeral 1 for a letter l. The number of these errors depends on the print quality of the original being scanned as well as the clarity of the fonts used. Find and Replace facilities in the editing software (Ctrl+H) can be used to good effect to clear up this type of error.

Another problem introduced by OCR software is that, if it is programmed to reproduce the appearance of the original text exactly, it will probably introduce a large number of styles of its own to the scanned version. This is not conducive to efficient editing and it is usually preferable to remove all formatting completely from the scanned version, then allocate the styles that the editor wishes to use from their own basic template for source documents. The simplest way to remove all formatting is to export or copy and paste the content into a text-only application such as Windows Notepad, and then copy and paste it back into a new document in the source document editing software, such as MS Word. It might also be possible to save the scanned text in a text-only file format directly from the OCR program.
The source document could be typed if there is no quicker way of obtaining an electronic version.

Whichever of the above methods is used to get a copy of the original material into the source document it should be proof-read carefully at this stage to ensure the accuracy. This is the starting point for all other preparation and transcription activities, so it would be most inefficient to have to correct errors after other processes are under way.

The author’s recommendation is that a single pass is made through the material at this point, simultaneously proof-reading the content against the original and applying heading styles and other formatting as the document is worked through.

3.2.2. Plain text (prose, poetry etc - words/sentences/paragraphs)

Text alignment

Text should usually be left-aligned (left-justified), although headings can be centred. It can be difficult for a large print or braille reader to locate the start of lines in centred or right-aligned text. Multiple columns should also be avoided unless regarded as essential to the purpose of the document.

Font weight &c

Font should usually be Regular weight; Bold should be used sparingly. Underscore, italic and decorative fonts are not as accessible as sans serif and plain serif fonts and should be avoided unless they are used in small amounts to illustrate a particular point. Users often have a preference for certain colours for text and background, especially in electronic documents. It's best to stick to the Automatic option for font colour (black text on white usually) unless the document is illustrating a point to do with
colour. Individual users can then override the Automatic setting with their preferred colours.

**Capital letters**

Upper case (capitals) should not be used for extended passages because in print it appears as a block of uniform height. This makes it hard to distinguish individual letters and word shapes.

### 3.2.3 Special symbols

Many symbols other than letters of the alphabet, punctuation and numeric digits are in use in most written material. Examples in common daily use include £, %, & and @. Others arise in mathematical texts ranging from elementary arithmetic (+ − ÷ =) to more advanced maths and science notation (° √ ∫ ∑ ∞ ≠). It is important that the correct symbols are used wherever possible because transcription software is often able to convert them correctly for use in alternative accessible formats, such as braille or audio. In particular a distinction should be made between the multiplication sign \( \times \) and the letter \( x \), and between the minus sign − and the hyphen - or various types of dash.

Some of these special symbols are on standard PC keyboards and typing them is trivial. Others can only be found in the Insert/Symbol/More Symbols dialogue in MS Word. Further details of various methods of typing special symbols are given in **Appendix 5**.

Accented letters in languages other than English will be covered in the section on **Foreign languages** below.

**Text alignment**

Text should usually be left-aligned (left-justified), although headings can be centred. It can be difficult for a large print or braille reader to locate the start of lines in centred or right-aligned
text. Multiple columns should also be avoided unless regarded as essential to the purpose of the document.

**Font weight &c**

Font should usually be Regular weight; Bold should be used sparingly. Underscore, italic and decorative fonts are not as accessible as sans serif and plain serif fonts and should be avoided unless they are used in small amounts to illustrate a particular point. Users often have a preference for certain colours for text and background, especially in electronic documents. It's best to stick to the Automatic option for font colour (black text on white usually) unless the document is illustrating a point to do with colour. Individual users can then override the Automatic setting with their preferred colours.

**Capital letters**

Upper case (capitals) should not be used for extended passages because in print it appears as a block of uniform height. This makes it hard to distinguish individual letters and word shapes.

**3.2.4. Tables**

A large print or braille version of a table can take up a great deal of space and an electronic document version for use with a screen reader can be quite confusing to navigate. Sometimes, however, a table is still the best way to display certain information, even though it may be difficult to produce an accessible version. The accessibility of tables can be improved if a few points are followed. Firstly it is important to think about the information being conveyed and how it will be used. Sometimes a table format is used when really the information contained in it is just a list. In this case a list format might be easier to put into an accessible form. Table format is only really required when the nature of the data is such that the user needs to cross-reference across rows and columns.
A feature that is often used to improve the visual presentation of a table is to merge some cells, so that a heading bridges two or more columns for instance. This can be confusing, particularly for screen reader users, and should be avoided. It might be necessary to duplicate the information that is common to two or more columns in each of the column heading cells.

Large tables can be split into smaller tables. If a table is split in two then there should be a row or column overlap, i.e. the same row or column occurring in both halves, with a short transcriber's note to point this out.

Cells containing large numbers can be divided by an appropriate power of 10 and the column or row heading and/or units adjusted to reflect this. The precision (number of significant digits in the numbers) should not generally be reduced; the information should be unchanged from the original, except possibly in the case of educational or exam documents where the material is to be not just transcribed, but modified appropriately for the student.

Another small step that would aid navigation in the accessible versions would be to use a heading style for the table title so that it appears in the Table of Contents. The Bookmark feature in Word can also be used to label column or row headings for improved screen reader access.

Finally it can also aid navigation within the table to describe its contents briefly, before the table itself. It is usually enough to state the number of columns and rows, and the type of information contained.

3.2.5. Foreign language text

MS Word and some transcription software have useful features to help the user to edit foreign language text.

The first problem is how to type the characters that aren't normally used in English, accented letters and others, on a keyboard that is
intended for typing English. There are at least four methods available, and the most suitable one is probably as much a matter of personal preference as any technical difference. Details are given in Appendix 7.

Another area where Word can help when editing foreign language text is spell checking. The template that is used to create documents in English should have UK English set as the default language for proofing, i.e. spell checking etc. This is indicated on the Status line at the bottom of the Word window. The correct language dictionaries for other languages can be brought into play if the foreign language text is selected and a different Proofing language specified. This is most effectively done by defining a Character Style named after the language in question and applying it to any words or sentences in that language in the source document.

It can also sometimes be helpful, especially in vocabulary lists, if the foreign text is in a different colour from the main English text of the document. This can also be specified as part of the Character Style.

The method of using a Character Style has the further advantage that some braille transcription software such as Duxbury Braille Translator can detect the foreign language from the style mark-up and use the appropriate braille transcription table for that language. Some screen readers are also able to detect such language settings and change

3.2.6. Maths and other technical content

Brief mention was made of how to deal with maths symbols in the Special Symbols section above. Slightly more support for editing maths and other technical notation is available in the MS Word Equation Editor facility, but for serious work of this type the Word Add-in 'MathType' from Design Science is highly recommended.
There is little if any control over the fonts used in Equation Editor and much maths notation (variable names etc) is traditionally in italics, which is not recommended for best accessibility. MathType has its own set of styles which can be altered to suit the requirements of a source document or an accessible document in other than 'standard' print.

Additionally MathType code is to some extent supported by some braille transcription programs.

3.2.7. Graphic Images - Alt text and other aspects

Textual information in an electronic document can be created and presented in various ways. If it is typed from a keyboard as plain text then accessibility is excellent. However, if it is presented as a graphic image (a picture, or a bitmap) of letters and digits the computer cannot necessarily interpret the characters as letters and numbers, screen readers might not recognise the text as such and accessibility is likely to be poor.

Graphic images might or might not be essential to the understanding of a document in alternative formats, especially braille and audio, so in some circumstances it is acceptable to omit them from an accessible version. The correct approach is to ensure that, if a graphic image contains information that the reader needs to have in order to make full sense of a document, then that information should be conveyed by means of 'Alt text', i.e. a text label that accompanies the image. Access technology such as screen readers can then access the Alt text and read it out at an appropriate point as the reader works through the document. Similarly the Alt text could be incorporated into a braille transcription.

It is a matter of judgement on the part of the person creating the source document for transcription to decide what should be included in the Alt text. It might range from a direct copy of text or numbers in the image to a more detailed explanation of a complex...
diagram such as a graph. Alternatively it could direct the reader to a table presenting the same information.

It is important that graphic images are formatted appropriately. They can be 'floating', i.e. positioned anywhere on the page in relation to the text, even over the top and obscuring the text. Alternatively it can be 'in line with text', in which case it behaves like any other piece of text and moves around as the software re-formats the page. The latter method is preferable for accessibility as it enables screen readers to be aware of the Alt text associated with the image and to read it out at the appropriate point.

It is also good practice to add a descriptive caption to the image in the body of the document and possibly to apply an appropriate style to ensure it is included in the Table of Contents.

For further details of how to add Alt text to a graphic image see Appendix 8.

3.2.8. Document Properties/Metadata

Meta data (or meta information) is data about data. In other words the meta data for a source document is data about the document, rather than any part of the data contained within the document. It can include items such as the author, the organisation, the dates of creation and latest modification and a summary of key words used within the document. If the document is to be made available within an organisation or publicly this meta data can be used in searches to help users to locate documents more efficiently. In practice the meta data is often called Document Properties. It is good practice for the creator or editor of a source document to complete the Document Properties if the document is to reach the intended audience.

Further details of how to edit Document Properties for Word documents are given in Appendix 9.
3.3. Editing a source document

The previous sections dealt with the principles of good practice in organising and creating the document content. This section focuses on a few practical tips that can make it as easy as possible to implement those principles.

3.3.1. Aids to efficiency

Show/Hide

It is most common for users to edit documents in Word in Print Layout view. In this view the effects of commands are displayed, e.g. pressing the space bar causes a blank space to be left between one word and the next; pressing Enter causes the insertion point to move to the next line and start a new paragraph, and so on.

Sometimes whilst editing it is helpful to see these commands displayed explicitly. This can be done by selecting Show with the Show/Hide button (¶) on the Home tab or by pressing the shortcut key Ctrl-Shift-8 (in effect Ctrl with *). This shortcut key is the 'toggle' type, i.e. alternate presses will switch the effect on and off again.

In Show mode spaces will be shown by a dot on the mid-line, like this: spaces·shown·by·dots. Similarly tab jumps are shown by a horizontal arrow → and the ends of paragraphs are shown by the pilcrow sign ¶. Making these symbols visible can be particularly helpful when diagnosing problems of paragraphing or aligning columns with tabs. The symbols will not show up when the document is printed unless the user selects an option to do so.

Document Map/Navigation & Outline View

When working with a complex document it is sometimes difficult to retain a clear mental picture of the overall structure. There are two ways to make this easier. The first is to display the Navigation Pane (called Document Map in earlier versions of Word).
The Navigation Pane is selected in the Show section of the View tab in the ribbon and, if selected, will appear as a narrow vertical pane on the left of the screen. Within this pane there are options to display the Headings in the document in a nested structure (as long as Heading Styles have been used!), or thumbnail pictures of the Pages of the document, or the Results of a search (a Find command). The Heading display allows the user to jump straight to any part of the document by clicking on a heading in the Navigation pane.

Outline View is similar to the Headings display in the Navigation pane but it allows the user to choose the number of heading levels displayed and to manipulate the headings by changing their level or moving them around the document. It can be selected from the Document View section of the View tab in the ribbon. The user can jump freely between Print Layout and Outline views whenever they wish.

**Shortcut keys**

Almost anything that the user can do with a mouse can also be done from the keyboard. Users who find using a mouse difficult or impossible can therefore still have access to most functions of a PC.

In most cases the labels printed on the keys show what character will appear on the screen when a key is pressed. Other commands can be given by pressing special keys, called modifier keys, at the same time as the standard keys. These combinations of keys are called shortcut keys because, even if the user doesn't have difficulty using a mouse, it is often quicker when working at the keyboard to press a shortcut key than to move a hand to the mouse, or to search for the appropriate icon or menu option in order to use the mouse.

Modifier keys include Alt, control (labelled Ctrl), Shift (usually labelled with an upward arrow ↑) and the Windows Key (labelled
with the MS Windows logo). Another one is AltGr, which usually has the same effect as pressing Alt and Ctrl together. A simple and common example of a shortcut key is to press Ctrl with B (by convention written as Ctrl+B) to make text bold rather than regular weight, or to revert to regular if it is already bold.

Lists of shortcut keys in Windows can be found by searching for 'shortcut keys' or 'keyboard shortcuts' in the online Help facility (mouse icon  or shortcut key F1 or f1 on the top row of the keyboard; 'F' and 'f' are used interchangeably for function keys) from the Windows Desktop or from the Windows Control Panel. Similarly in any application such as Word the Help screens (shortcut F1) will display a search window where the user can search for shortcut keys relevant to that application. Sometimes shortcut keys are shown when a Tooltip is activated. (Tooltips are short amounts of text that explain the function of an icon or other object when the mouse pointer passes over it.) There are many hundreds of shortcut keys in the Help lists so they are not included in this document. However, a few specific examples are listed under various tasks in the Appendices.

At the simplest level it is possible to learn a few of the most common shortcut keys and not to worry too much about how the system works. However, with a slightly deeper level of understanding shortcut keys can be used to make significant improvements to the user's speed and efficiency when editing documents. Shortcut keys are associated with different parts of the software used in a PC, the three main areas being the operating system (Windows), the application software (in this case Word) and the access software, if any, such as a screen reader. For the purposes of this guidance the first two types will be described, but not shortcuts in the context of access software.

Some shortcut keys are the same in Windows and Word because they do similar things, although the exact function varies according
to the context. An example is the Copy command Ctrl+C. In Windows this might copy a file in Windows Explorer to the Clipboard, whereas in Word it is used to copy a section of text or a graphic image to the Clipboard.

Other shortcuts do completely different things in the two contexts, such as the Shift key.

- **Example 1:** In most Windows dialogues the Shift key is used to reverse movement commands. The Tab key when pressed alone moves the focus around the options in a dialogue box; Shift+Tab moves the focus back through the same cycle of options in the opposite direction.

- **Example 2:** In Word the normal function of the Shift key is to change letters from lower case to upper case or vice versa.

- **Example 3:** In Word the Tab key moves the insertion point (cursor) to the next default or defined tab stop; pressing Shift+Tab has the same effect as pressing Tab on its own, i.e. it has no special purpose, unlike its use in Example 1 above.

Some shortcut keys are 'frozen' into the software and cannot be altered; others can be changed or new ones added. Particular uses for user-defined shortcuts include typing special symbols in MS Word (e.g. Alt+D could be used for the division sign ÷ and Alt+M for the multiplication sign ×) and selecting user-defined styles (e.g. Alt+8 for a French language character style). With care a system of shortcuts can be built up to meet the needs of a particular user in order to make their day-to-day working more efficient. Furthermore this can be done without interfering much, if at all, with the shortcuts already defined in the software. Appendix 5 contains lists of some of the most useful shortcut keys and Appendix 6 describes how to create and modify shortcut keys in Windows and Word.

A final note about shortcut keys is to introduce the idea of specific and generic shortcuts. There are hundreds of shortcuts defined for each piece of software, many more than most users can
remember. A specific shortcut is one that performs a task or operation immediately at the insertion point, e.g. Ctrl+B to turn bold font weight on or off. Generic shortcuts are ones that help the user to locate a function quickly and easily in menus or dialogue windows, e.g. Alt to display the menu bar in an application, or Tab to move through the options in a dialogue. Generic shortcuts are useful when there is no specific shortcut defined for a task, or when the task is one that is performed infrequently so that it is not worthwhile for the user to remember the specific shortcut.

3.3.2. Good practice in general editing techniques

There are some aspects of good practice in editing with a word processor that ought to be taught to everyone in the early stages of learning word processing, but that are sometimes overlooked. One of the commonest is how to stop adding text to a page, but to start new text at the top of the next page. The intuitive way is for the user to insert blank lines by pressing the Enter key repeatedly until the insertion point (cursor) is on the first line of the next page. If the text is re-formatted at a later date, for example by a change of font or line spacing, the number of blank lines is likely to be incorrect and will require adjustment. The correct way to jump straight to the top of the next page is to use the Page Break command, either from the ribbon or with the shortcut Ctrl+Enter. The new text will start at the top of the next page (in most cases) regardless of future changes to formatting.

The distinction between line breaks and paragraph breaks is another area that is sometimes overlooked.

The definition of a paragraph in Word was mentioned earlier, namely the text contained between two places where the Enter (Return) key has been pressed, marked by the pilcrow sign ¶ if the Show setting of the Show/Hide function is selected. The Normal style definition, the one usually used for basic paragraph text,
sometimes includes a value for line spacing and values for the space before and after each paragraph.

Sometimes it is required to format a line within a paragraph differently from the rest of the paragraph, like this:

   Line within paragraph centred instead of left-aligned.

In this case it is desirable to have the same line spacing, but not to have the extra spacing that would be added between paragraphs; a 'line break' is designed to do this. The shortcut Shift+Enter will insert a line break, i.e. move the insertion point to a new line at the standard line spacing, but without inserting a paragraph symbol ¶ or any extra paragraph spacing. In Show mode the symbol ← indicates a line break.

4 Summary

Creating documents in a variety of accessible formats can be a complex and time consuming process. This process can be made more efficient and reliable if the editor of a source document for transcription follows the principles of good practice outlined here. This can be made easier by taking advantage of technical facilities such as styles and shortcut keys that exist in the editing software.

5 References

1 Creating Accessible Documents, Susan Burn, Scottish Accessible Information Forum, 2014.

2 Tips on using Word for UKAAF UEB information day, James Bowden, Dolphin Computer Access Ltd, November 2012.

3 Tips for producing Word documents, Mandy White, RNIB, 2015.

6 Appendices - general Notes

In the following Appendices it is assumed that the reader is familiar with basic operation of their version of MS Word or a similar word processor, by means of the mouse or keyboard and with or without access technology. In particular it is assumed that they know how to find things in the menu system for older versions or in the ribbon for newer versions.

7 Appendix 1 Using styles and templates

7.1. How to select one or more blocks of text

Before starting to use or alter styles the user need to know how to select one or more blocks of text.

- Selecting with the mouse:
  Double-click (left button for a right-handed mouse) anywhere within a word to select the whole word, or drag (press, then hold the left mouse button whilst moving) across the text to be selected. (The behaviour might be different depending on the selections in the ribbon File/Options/Advanced dialogue and the user might like to change them to suit their preference.) Triple-click to select the whole paragraph.

- Selecting with the keyboard:
  Hold down either left or right Shift key (⇧) at the same time as pressing any of the normal cursor movement keys, e.g.:
  - right cursor key to select a letter at a time
  - Ctrl with right cursor key to select a word at a time
  - Ctrl with down cursor key to select the rest of a paragraph at a time
  - PgDn (Page Down) to select a screen page at a time.

It is sometimes useful to select the whole document (‘Select All’ in the Edit menu, ribbon Editing tab, or shortcut Ctrl+A). This is useful when starting a new source document that has been scanned with OCR software or copied and pasted from a different file format. It is a good starting point to select the whole document and apply the
Normal style. Then work through to proof-read the text and apply heading and other styles as appropriate.

To select words, sentences or paragraphs that are not all in one continuous block select the first one as described above, let go of all keys or mouse buttons, then hold down the Ctrl key as additional words, sentences or paragraphs are selected.

7.2. Working with styles

7.2.1. How to apply or remove styles

Some of the styles that are already defined and available can be seen in the Style section of the Home tab on the ribbon. Click on the little arrow at the bottom right of the Styles section (shortcut Alt+Ctrl+Shift+S; toggle) and the Styles window will be displayed, showing a greater number of styles.

To use the Styles window from the keyboard press F6 repeatedly until the focus is on the title bar of the window (it will change shade or colour) then use the down or up cursor keys and Enter to select a style. Use F6 to return to the text. Don’t forget to position the cursor on what the style is to be applied to before selecting the style. (This process is easier still with a shortcut key; see Shortcuts for Word Styles in Appendix 6.)

To apply a paragraph style to a single paragraph place the insertion point (cursor) anywhere in the paragraph. Then select the style to apply, either from the ribbon display (Home tab), or the Styles window, or in earlier versions of Word from the Format menu, Styles and Formatting option. If the style applied is visibly different from the previous style of the paragraph the difference will be seen immediately.

To apply a paragraph style to more than one paragraph select the paragraphs, then select the style as described above.
To apply a character style select the text to which the character style is to be applied, then select the character style from the ribbon or menu.

The simplest way to remove an unwanted style is to revert the paragraph to Normal style, preferably with a shortcut key. Any special character formatting can be removed by selecting the text and typing the shortcut Ctrl+Space.

### 7.2.2. How to modify a style

If the mouse pointer is hovered over any of the styles in the Styles window a brief summary of the characteristics of that style is displayed. Press the right mouse button (shortcut Shift F10) to see the context menu for that style and select 'Modify' or press 'M'. The Modify Style dialogue will be displayed.

Most of the options in the Modify Style dialogue are self-explanatory. However, the most important part is hidden in the Format drop-down menu in the bottom left-hand corner. This contains almost all of the options that will already be familiar for formatting in Word: text characteristics, spacing and alignment, paragraph spacing and indentation, and so on. The difference is that the options and values selected here will apply to any text to which this particular style is applied.

One item in the Modify Style/Format menu that does not appear in other formatting menus is Shortcut key. This enables the user to define a shortcut key to apply this style. This is very quick and so is useful for the styles that are to be used most often. It will be explained in Appendix 5 Creating and modifying shortcut keys.

The 'Automatically update' box should be ticked so that all instances of a style in a document are updated whenever that style is modified.

The user should be clear in their mind whether they wish the styles they modify to be saved only within the current document, or
should be saved in a template that can be used for other documents. In the latter case they should first open the template, not as a new blank document but with file type 'Word template' or 'All Word templates' specified in the Open file dialogue. Templates are covered in more detail in Working with templates below.

7.2.3. How to create a new style

There is a mouse button to create a new style at the bottom left of the Styles window. The Create New Style dialogue is very similar to the Modify Style dialogue.

It is helpful to choose a meaningful name for the new style.

There is a drop-down menu for 'Style based on'. It is usually a good idea to set this to Normal, the default paragraph text style, as there will probably be only a small number of features that need to be different from the Normal style. Alternatively if a new style is needed that is similar to the List Bullet style then that could be selected for 'Style based on'.

Once created the new style will appear in the Styles window. Like any other style it can be modified at any time, so there is no pressure to get all the features of the style right first time.

7.3. Working with templates

7.3.1. How to create a new template

A template is a special form of word processor file containing a collection of styles and other information that is used to create a new document. A new document can be created at any time, whilst working in a Word document, with the shortcut key Ctrl+N. This will automatically create a new blank document based on the template file Normal.dotm.

However, if the user goes to the File tab on the ribbon and selects 'New' a wider range of templates for new documents is displayed.
Most of these are created by Microsoft and supplied with Word, but any that the user creates are usually stored in the folder My Templates.

A new template might be needed for documents to suit a particular purpose, such as a particular large print user, or source documents for translation into braille. The parameters of the Normal template could just be altered to do this, but it is better to create a separate template for each purpose.

The easiest way to do this is to start with a document that already has at least some styles defined for the large print user. Any text in the body of the document would appear in new blank documents, so usually this must be deleted before the template file is created.

To create the template file:

1. Go to File in the ribbon, then Save As.
2. In the 'Save as type' drop-down menu select 'Word template (*.dotx)'.
3. The displayed folder location should change to: `C:\Users\user name\AppData\Roaming\Microsoft\Templates`. If it doesn't then it can be changed by browsing as usual in Windows Explorer. (This is the location for MS Word 2010. For a different version look in the advanced options section for the 'File locations'; this should list the location of User Templates; move to this location in the Save As dialogue. Alternatively try the online Help or search for 'Templates' in Windows Explorer.)
4. In the 'File name' edit box type a meaningful name for the template and press Enter or click Save. If an error message appears saying that a file of this name already exists check whether the previous one should be overwritten; change the new template file name if the earlier one is to be kept.

The new template should now appear in the My Templates section of the File/New dialogue and should allow the creation of new files based on this template.
7.3.2. How to edit an existing template

Editing a template file is more or less the same as editing any Word document, except to ensure that it is opened as a template (i.e. select File type Word template in the Open file dialogue) and saved as a template. This is to distinguish editing a template from editing a document created from a template.

8 Appendix 2 Creating & customising a Table of Contents

8.1. To create a Table of Contents (ToC) for a document in Word 2010

1 Place the cursor (insertion point) where the ToC is to start.
2 Go to the References tab of the ribbon.
3 Table of Contents is the first section on the left; click the drop-down arrow.
4 For the simplest possible ToC without unnecessary fancy formatting go to Insert Table of Contents near the bottom of the drop-down; the Table of Contents dialogue will open.
5 The settings displayed are fairly obvious. The number of levels to show might need to be adjusted. It can be changed later if necessary.
6 Select Hyperlinks if the user is to be able to click on headings in the ToC to jump straight to that section in the document.
7 Click the Options button (or Tab to it and press Enter) to match Heading style levels to ToC levels. If Heading Style 1 is used for the document title, as is common practice, then only Heading Style 2 onwards will be needed in the ToC. Set Heading level 2 to ToC level 1, Heading level 3 to ToC 2 and so on for the levels to display in the ToC.
8 Click OK or press Enter twice and the ToC should appear in the document. Check that it is as required.
9 Save the file.
8.2. To edit the ToC settings

10 If anything in the ToC settings is to be changed, position the cursor at the start of the ToC and open the context menu (right mouse click, Shift F10 or Windows menu (application) key).

11 Select Edit Field.

12 Select Table of Contents; the Table of Contents dialogue should open again and the settings made earlier can be modified; return to step 5 above.

8.3. To update a ToC

If minor changes have been made to a document that will affect the page numbers in the ToC, or more major changes such as inserting a new section, it will be necessary to update the ToC.

13 Position the cursor at the start of the ToC and open the context menu (right mouse click, Shift F10 or Windows menu (application) key).

14 Select Update Field.

15 If minor changes have been made to the document select 'Update page numbers only'; otherwise select 'Update entire field'. The ToC will be updated. Save the file!

9 Appendix 3 Paragraph, line, page, section and column breaks

9.1. Paragraph break

When Enter (sometimes called Return) is pressed whilst typing, the cursor is moved to a new line and a new paragraph with the same style and formatting options is started. The amount of blank space at the end of one paragraph and the start of the next is set by the style in use, for ordinary paragraph text this is usually the Normal style. When Show/Hide is set to Show, a paragraph break is indicated by the pilcrow symbol ¶.
9.2. Line break
Shift with Enter causes the cursor to be moved to the start of a new line, but a new paragraph is not started and the line spacing is the same as other lines in the same paragraph. In Show mode a line break is indicated by the symbol ↑.

If a style is applied to a paragraph containing line breaks the style will be applied throughout the paragraph, both before and after any line breaks, up to the end of the paragraph.

9.3. Page break
Press Ctrl+Enter to force the text to continue at the top of the next page, regardless of how far down the current page the cursor is. A paragraph break is also inserted at the point where Ctrl+Enter is pressed.

9.4. Section break
A section break is a logical division of the document, not necessarily connected to any visible feature (unless Show mode is set). This is useful, for example, when a header contains the chapter number or title. It is necessary to insert a section boundary and to define the changed header for the pages following the section boundary. The page numbers usually continue through a document across chapter boundaries and must therefore be set to continue across section breaks.

Section breaks can be found in the Page Layout tab of the ribbon, in the Page Setup section. Further technical details can be found in the online Help pages.

9.5. Column break
Newspaper or magazine type columns are not usually recommended in accessible documents. However, if they are required for some specific reason, it might be useful to know that it
is possible to jump to the start of the next column, regardless of how far down the current column the cursor is, by pressing Ctrl+Shift+Enter.

9.6. Non-breaking space

It is sometimes easier to read text if certain items are kept together on the same line. For instance, it might be considered helpful to keep 'Mr.' and 'Smith' together, rather than allow the word processor to leave 'Mr.' at the end of one line and 'Smith' at the start of the next. A non-breaking space is designed to enable this; replace an ordinary space with Ctrl+Shift+Space. In Show mode it looks like a degree sign °.

10 Appendix 4 Editing headers and footers

To insert a page number in a footer follow the instructions below. This is not the only method in Word, but it produces the simplest text layout, avoiding graphic text boxes and other features that might interfere with accessibility.

1 Go to the Insert tab of the ribbon.
2 In the Header & Footer section click on Footer.
3 Near the bottom of the drop-down menu click on Edit Footer.
4 A new tab Header and Footer Tools will appear on the ribbon.
5 In the Insert section click on Quick Parts.
6 Click on Field.
7 In the Field dialogue locate Page and click OK or press Enter; the page number will appear in the Footer.
8 The page number font, size and so on will have been set automatically by the Footer style. Make changes to this style to give the page number the appearance and position required.

Follow a similar method to create a header.
If a header or footer has already been defined then the quickest way to edit it is with a mouse left double-click in the header or footer area.

11 Appendix 5 A small selection of useful shortcut keys

As indicated in the main text most people can only conveniently memorise a limited number of shortcut keys; beyond that it is more efficient to use more general strategies to find the commands and options required. The number that can be memorised will vary between individuals so this list is inevitably subjective.

11.1. Useful shortcut keys in Windows

On recent desk-top and lap-top PCs there is a special modifier key called the Windows Key. It has a picture of the Microsoft Windows logo (a wavy window) printed on it. The following list shows the effect of pressing the Windows Key (WK) alone or with other keys.

<table>
<thead>
<tr>
<th>keys to press</th>
<th>effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>WK alone</td>
<td>Open/close the Start Menu (toggle)</td>
</tr>
<tr>
<td>WK with D or M</td>
<td>Minimise all active windows and move the focus to the Desktop (toggle)</td>
</tr>
<tr>
<td>WK with E</td>
<td>Start Windows Explorer</td>
</tr>
<tr>
<td>WK with F1</td>
<td>Windows Help</td>
</tr>
<tr>
<td>WK with R typed</td>
<td>Run a program when the program file name is typed</td>
</tr>
<tr>
<td>WK with U</td>
<td>Utility Manager for Magnifier, Narrator and On-screen Keyboard</td>
</tr>
</tbody>
</table>
11.1.1. Opening and closing programs

Windows key or Ctrl+Esc opens the Start menu; use the first letter of the program to be opened or use the Search command.

Alt+F4 closes any program that is running.

11.1.2. Moving around in Windows

- cursor keys make the smallest movements, e.g. a character at a time when editing, or up and down a menu an item at a time.
- Ctrl+cursor keys make a slightly bigger movement, e.g. a word at a time when editing.
- Home jumps to the start of a list; End to the end.
- Sometimes Ctrl+Home or Ctrl+End make a bigger jump, e.g. to the top or bottom of a window.
- Tab or F6 jump between items in a dialogue or panes within a window.
- Ctrl+Tab makes a bigger jump than Tab, e.g. between tabs in a dialogue.
- Alt+Tab jumps between programs that are running.

In addition:

- Shift with most movement commands changes the direction of movement through a list or sequence, e.g. Shift+Tab moves through the items in a dialogue in the opposite direction to Tab.

Another shortcut that is occasionally useful, especially with screen readers:

- Alt+Space enters the individual window menu for any program.
- X selects Maximise the window.

11.1.3. Working with menus in Windows programs

Menus used to be the main way of working with programs but have largely been replaced by methods with a greater graphical emphasis. Nevertheless, well-behaved Windows programs still contain a menu structure and respond to the same commands.
• Alt will take the focus into the menu bar, or leave it and return to the previous focus.

• Left and right cursor keys will move the focus between the tabs or sub-menus.

• Down and up cursor keys will move the focus down or up in a sub-menu. Also moving up from the top of the menu will usually move the focus to the bottom item, i.e. wrapping round, which can be the quickest way to the bottom.

• Enter (Return) will select a menu item and cause it’s action to be implemented.

In addition:

• Menu items may have a letter underlined, sometimes the first letter, but sometimes, if there are duplicate items starting with the same letter, a different letter, e.g. File and Format. These items can be triggered immediately from the program, without activating the menu, by pressing Alt with the underlined letter.

• Sub-menu items may also have a letter underlined, but in this case just press the letter to select that option once the menu is open.

11.1.4. Cut, copy and paste in Windows

Items such as files in Windows Explorer can be cut, copied or pasted:

• Cut Ctrl+X - hint: X looks like scissors, which cut

• Copy Ctrl+C

• Paste Ctrl+V - hint: near X and C on the keyboard

11.2. Useful shortcut keys in Word

11.2.1. Opening and closing documents

• Ctrl+O (letter ‘o’) to open a document - take care to select the file type and location.

• Alternatively the version of Word in use might have the option Recent or a list of recently edited files in the File menu. This is
sometimes helpful if the user can't remember or doesn't know the folder where the file is stored.

- **Ctrl+S** to save a file; if it is a new document that hasn't been saved before the user will be asked for a file name, file type and location. If it has been saved before it will be updated immediately in the same location as before.

- **Ctrl+F4** to close the document, but leave Word running. If a file hasn't been saved since the last change the user will be asked whether to Save it before the document is finally closed.

- **Alt+F4** to close all files and close Word.

### 11.2.2. Moving around in Word

- Left or right cursor keys - one character at a time.
- Ctrl with left or right cursor keys - one word at a time.
- Home or End - start or end of the current line.
- Up or down cursor keys - one line at a time.
- Ctrl with up or down cursor keys - a paragraph at a time.
- Ctrl with Home or End - start or end of the whole document.
- Shift+F5 - return to the previous location after a move; cycles round the last few moves.
- Ctrl+F6 - switch between two or more open documents.

### 11.2.3. Working with menus in Word

See [Working with menus in Windows programs](#).

### 11.2.4. Cut, copy and paste in Word

See [How to select one or more blocks of text](#) and [Cut, copy and paste in Windows](#).

In addition there are some formatting options associated with paste. Right-click the mouse at the position where text is to be pasted and there are options to keep the source formatting, merge formatting with the destination (i.e. use the Style at the destination), or paste the text unformatted. Usually the last option
is the safest, unless the pasted text contains special formatting that is to be preserved.

11.2.5. More shortcuts in Word

For a comprehensive list of Word shortcuts press Alt+F8 (run a macro), type 'listcommands', choose a list and press Enter. A list will be created in a separate document with more shortcuts than any user could ever wish for.

12 Appendix 6 Creating and modifying shortcut keys

It was explained in the main body of this document that it is possible for a user to define some shortcut keys to suit their own needs.

12.1. Creating shortcut keys in Windows

A very good use for user-defined shortcut keys in Windows is to start programs. For instance if the user is in the middle of working on a word processor document and they wish to launch an online dictionary program it is much quicker to do this with a single shortcut than to locate the dictionary program in the Start Menu or on the Desktop.

A good choice for this group of shortcut keys is to use the AltGr key, to the right of the space bar, with the first or another meaningful letter of the program name, e.g. AltGr+D for an English Dictionary. The AltGr key does the same as the Alt and Ctrl keys together, in most circumstances, and doesn't conflict with other common Windows shortcuts.

How to create this type of shortcut:

1 The shortcut key must be created in association with a Desktop icon for the program. If there isn't one already it is necessary to locate the main program file in Windows Explorer, usually on the C: disk drive in folder Program Files (x86) and usually a filename ending '.exe'. Right-click on the
file icon (or use the Windows Application menu key) and select Create Shortcut; a shortcut icon will be created in the same folder. Cut this shortcut icon out of this folder (Ctrl+X) and Paste it on the Desktop (Ctrl+V).

2. Right-click on the program icon (or move to it using the keyboard - Windows key+D, then cursor keys, then Windows Application key) and select Properties.

3. Click in the 'Shortcut key' edit box or Tab to it and type the shortcut key to be used, e.g. AltGr+D, then click or Tab to Apply, then click OK or press Enter.

4. Check that the shortcut key that has been set up works as expected and launches the program.

It might be necessary to avoid certain combinations if they already do something in other programs, such as Word.

Some suggested shortcut keys to start programs:

- AltGr+B: braille translation program
- AltGr+C: calculator
- AltGr+D: dictionary
- AltGr+E: Excel
- AltGr+W: Word or other word processor

### 12.2. Creating shortcut keys in Word

There are many situations in Word where a task requires several mouse clicks or keyboard steps through menus and dialogues. If such a task is performed often it is worthwhile to set up a shortcut key to do it in one keystroke.

#### 12.2.1. How to set up a shortcut key for a special symbol

A couple of examples have already been given in the main text of this document where a shortcut can be used to type a special symbol that isn't on a normal keyboard, such as mathematical operators ÷ × (multiply) and √. There are other ways of typing these characters directly, using the 4 digit hexadecimal Unicode
numbers followed by Alt+X, but these codes are not necessarily easy to remember. A user-defined shortcut using meaningful letters connected with the desired symbol is likely to be easier to recall.

1 Locate the symbol in the ribbon/Insert tab/Symbol dropdown/More Symbols dialogue; the Customize Keyboard dialogue will appear.
2 Change ‘Save changes in’ to the current document.
3 Check the Current Keys box to see whether any shortcuts are already defined for this symbol. Consider whether to use this shortcut, or Remove it and use a different one.
4 Type the new shortcut in the ‘Press new shortcut key’ edit box.
5 If this shortcut is already in use it will be listed as ‘Currently assigned to:’ just below the ‘Current keys’ box.
6 If the user is happy to overwrite the currently assigned function of this shortcut, click Assign and click Close.
7 Check that the chosen shortcut inserts the correct symbol.
8 Save the file.

If these shortcut keys are to be saved in a template rather than in an individual document it is necessary to open the template file as a Word template, create the shortcuts and save the template file again at the end.

Here are some lists of shortcut keys for special symbols that the user might find useful. Some characters are not available in all fonts, so the font must be specified. If the listed font has not been installed in the computer it will be necessary to locate the symbol in a different font.

### 12.2.2. Mathematical symbols

<table>
<thead>
<tr>
<th>shortcut key</th>
<th>symbol name</th>
<th>symbol</th>
<th>font</th>
<th>Unicode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+D</td>
<td>divide</td>
<td>÷</td>
<td>current font</td>
<td>00F7</td>
</tr>
<tr>
<td>Alt+M</td>
<td>multiply</td>
<td>×</td>
<td>current font</td>
<td>00D7</td>
</tr>
</tbody>
</table>
12.2.3. Fractions

<table>
<thead>
<tr>
<th>shortcut key</th>
<th>symbol name</th>
<th>symbol</th>
<th>font</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+1</td>
<td>one half</td>
<td>½</td>
<td>current font</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>one third</td>
<td>⅓</td>
<td>Arial</td>
</tr>
<tr>
<td>Ctrl+3</td>
<td>two thirds</td>
<td>⅔</td>
<td>Arial</td>
</tr>
<tr>
<td>Ctrl+4</td>
<td>one quarter</td>
<td>¼</td>
<td>current font</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>three quarters</td>
<td>¾</td>
<td>current font</td>
</tr>
<tr>
<td>Ctrl+6</td>
<td>one eighth</td>
<td>⅛</td>
<td>current font</td>
</tr>
<tr>
<td>Ctrl+7</td>
<td>three eighths</td>
<td>⅜</td>
<td>current font</td>
</tr>
<tr>
<td>Ctrl+8</td>
<td>five eighths</td>
<td>⅝</td>
<td>current font</td>
</tr>
<tr>
<td>Ctrl+9</td>
<td>seven eighths</td>
<td>⅞</td>
<td>current font</td>
</tr>
</tbody>
</table>

12.2.4. Shortcuts for Word Styles

Applying heading and other styles is a large part of the work when preparing a source document for transcription. It might therefore be convenient to define shortcut keys for the ones to be used most often.

A shortcut for a Word style is set in the Modify Style dialogue. The Format drop-down menu includes the item 'Shortcut key', which
leads to the 'Customize Keyboard' dialogue, as described in the section above How to set up a shortcut key for a special symbol.

The set of shortcuts listed below has been found to be useful and doesn't conflict with other shortcut keys.

Alt+0 Normal or Body Text Style
Alt+1 Heading 1 Style
Alt+2 Heading 2 Style
Alt+3 Heading 3 Style
Alt+4 Heading 4 Style
Alt+5 Heading 5 Style
(Alt+6-9 used for special purposes)
Ctrl+Shift+L List Bullet Style
Ctrl+Shift+N Numbered Style

13 Appendix 7 Typing in foreign languages

There are at least 4 different ways of typing the accented and other characters that occur in languages other than English, but which are not included on a standard English keyboard:

- Insert the special characters using the Insert Symbol dialogue.
- Type the four-digit hexadecimal Unicode number, e.g. 00E9 for e-acute (é), followed by Alt+X.
- Change the keyboard to one designed for the language required and change the keyboard language selection in Windows.
- Control (Ctrl) key shortcuts.

The last one is believed to be the simplest and most intuitive to remember, but users may have their own preference.
The instructions below enable the user to type all of the accented characters in French, German and Spanish.

13.1. The Control Key Shortcuts Method

The idea behind the method is that the Control key is pressed at the same time as a punctuation character, which is visually similar to the required accent, followed by the letter that is to have the accent.

For example in order to type a lower case e-acute (é):

- press the Control key with the apostrophe key (’ usually just to the right of the semicolon key ;)
- release the Ctrl and apostrophe keys
- press and release the E key.

For upper case e-acute (É) press Control with apostrophe followed by Shift with the E key.

13.2. Table of Accents & Associated Control Keys

<table>
<thead>
<tr>
<th>Accent</th>
<th>Keys to press with Ctrl</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>acute</td>
<td>apostrophe ’ (single quote)</td>
<td>a-acute lower case (á) e-acute upper case (É)</td>
</tr>
<tr>
<td>cedilla</td>
<td>comma ,</td>
<td>c-cedilla lower case (ç) c-cedilla upper case (Ç)</td>
</tr>
<tr>
<td>circumflex</td>
<td>caret ^ (Shift 6)</td>
<td>a-circumflex lower case (â) o-circumflex upper case (Ô)</td>
</tr>
<tr>
<td>dieresis or umlaut</td>
<td>colon : (Shift with semicolon ;)</td>
<td>e-dieresis lower case (ë) u-umlaut upper case (Ü)</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
<td>Examples</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>grave</td>
<td>opening quote `</td>
<td>a-grave lower case (à)</td>
</tr>
<tr>
<td></td>
<td>(left of 1, but not consistent)</td>
<td>e-grave upper case (È)</td>
</tr>
<tr>
<td>tilde</td>
<td>tilde ~ (Shift #)</td>
<td>n-tilde lower case (ñ)</td>
</tr>
<tr>
<td></td>
<td>(right of apostrophe</td>
<td>n-tilde upper case (Ñ)</td>
</tr>
<tr>
<td></td>
<td>but not consistent)</td>
<td></td>
</tr>
</tbody>
</table>
13.3. Other Special Characters

There are a few other special characters used in foreign languages which can also be generated with the Control key, but which do not follow the above pattern.

<table>
<thead>
<tr>
<th>character</th>
<th>keys to press</th>
</tr>
</thead>
<tbody>
<tr>
<td>oe diphthong (lower case œ)</td>
<td>Ctrl+&amp; (i.e. Ctrl+Shift+7)</td>
</tr>
<tr>
<td></td>
<td>then the O key</td>
</tr>
<tr>
<td>oe diphthong (upper caseŒ)</td>
<td>Ctrl+&amp; (i.e. Ctrl+Shift+7)</td>
</tr>
<tr>
<td></td>
<td>then Shift with the O key</td>
</tr>
<tr>
<td>double s (beta s) ß</td>
<td>Ctrl+&amp; (i.e. Ctrl+Shift+7)</td>
</tr>
<tr>
<td></td>
<td>then the S key</td>
</tr>
<tr>
<td>exclamation opening ¡</td>
<td>Ctrl+Alt+! (i.e. Ctrl+Alt+Shift+1)</td>
</tr>
<tr>
<td>question opening ¿</td>
<td>Ctrl+Alt+? (i.e. Ctrl+Alt+Shift+/)</td>
</tr>
</tbody>
</table>

14 Appendix 8 Adding Alt text to a graphic image

- Right-click on the image or move to it using the keyboard and press Shift+F10 or the Windows Application key.
- Select 'Format Shape' or 'Format Picture', usually at the bottom of the menu.
- Select 'Alt text', usually near the end of the menu.
- Complete the Title and Description edit boxes and click Close.

15 Appendix 9 Editing Meta data/Document Properties

- Go to the Ribbon File tab.
- Select the Info section.
Click on the 'Properties' drop-down menu at the top right of the screen. Select 'Show Document Panel' and complete the fields in the new panel displayed below the ribbon. (Alternatively select 'Advanced Document Properties' and edit the same fields in the 'Summary' tab.)

16 Where to get further help
UKAAF assists businesses and organisations by advising how to meet the needs of customers and clients with print disabilities; providing guidance on how to source and provide quality accessible formats like large print, audio, braille, electronic file formats and Easy Read; and helping you to understand your responsibilities as a service provider.

Through our website and magazine, members will also gain access to:

• findings from public consultations and end-user research
• research and innovation in accessible formats
• information on suppliers of transcription services
• guidance and advice on standards for accessible formats
• opportunities to review and help to develop standards and guidance.

In addition to supporting service providers and transcribers, UKAAF also represents people with print disabilities. We believe that because format quality matters, end-users should have genuine input into the development of standards for accessible information. By collecting and sharing users' views with service providers and transcribers we can help them to deliver a quality service which meets users' needs.
UKAAF has a User Advisory Group (UAG) so we can include blind and partially sighted people and others with print disabilities in ongoing research and consultation on key accessible format issues.

There are many benefits of being a member of UKAAF, not least to demonstrate your commitment to quality accessible formats. For more information visit us at www.ukaaf.org.

17 Your feedback is welcome

We would welcome your views on this guidance, any suggestions for additions, or case studies of how this guidance has helped you. You might like to share your experience in an article in our magazine 'Format Matters'.

You can phone, email or write to us - our details are at the back, or use the feedback form on our website www.ukaaf.org.

If you find UKAAF's guidance valuable, please encourage others to join by visiting our website.
## Document reference information

<table>
<thead>
<tr>
<th>Document title</th>
<th>Accessible PDF for Assessments: Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>UK Association for Accessible Formats (UKAAF)</td>
</tr>
<tr>
<td>Document ref</td>
<td>G019</td>
</tr>
<tr>
<td>Version number</td>
<td>1.0</td>
</tr>
<tr>
<td>Publication date</td>
<td>July 2015</td>
</tr>
<tr>
<td>Review date</td>
<td>October 2015</td>
</tr>
<tr>
<td>Document purpose</td>
<td>Good practice guidance protocol for producing assessments in accessible PDF format</td>
</tr>
<tr>
<td>Primary contributors</td>
<td>UKAAF Electronic Documents subject group</td>
</tr>
<tr>
<td></td>
<td>Susan Day – V I Resourcing Ltd</td>
</tr>
<tr>
<td></td>
<td>Abi James – BDA &amp; Assistive Learning Ltd</td>
</tr>
<tr>
<td></td>
<td>Alistair McNaught – Jisc TechDis</td>
</tr>
<tr>
<td></td>
<td>Paul Nisbet – CALL Scotland</td>
</tr>
<tr>
<td></td>
<td>Sharon Williams – PIA</td>
</tr>
<tr>
<td>Board approval</td>
<td></td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>With thanks to all previous contributors, including Dave Gunn, RNIB, Andrew Homer, RNIB, Kiran Kaja, Adobe.</td>
</tr>
<tr>
<td>Superseded documents</td>
<td>N/A</td>
</tr>
</tbody>
</table>
UK Association for Accessible Formats (UKAAF)

Contact details
UKAAF
c/o Gwasg Pia Cyf
Unit 42, John Baker Close
Llantarnam Ind Est
Cwmbrân
NP44 3AW

Tel: 0845 60 85223
Fax: 0845 60 85224
Email: enquiries@ukaaf.org
Web: www.ukaaf.org

Registered address
UKAAF
c/o Gwasg Pia Cyf
Unit 42, John Baker Close
Llantarnam Ind Est
Cwmbrân
NP44 3AW

President: Lord Low of Dalston CBE
Registered charity number: 1126966
Registered as a company in England and Wales number: 67489